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Introduction:

This document contains information about how to install Lightsolve, how to create a SketchUp

model which is recognizable by Lightsolve, how to run the renderer and how to navigate the

Lightsolve interface. It also contains tips for troubleshooting known problems.
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NOTE: If you are not on the Lightsolve_announce list (i.e. if you haven’t yet received any of the

Lightsolve_announce emails) but are interested in this program and in getting new releases, send a
message to Marilyne Andersen (marilyne.andersen @ epfl.ch) requesting to be added to the list.
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0. Installation

FIRST : Make sure you have access to the C drive on your computer.

To use this version of LightSolve, you must have administrative privileges on the C drive of your
computer. If it is your own computer, you most likely do. If you are using a school or company
computer, you are likely networked and may not have the correct access.

IMPORTANT : THIS IS A RESEARCH TOOL, VERY SENSITIVE TO PROPER INSTALLATION. PLEASE FOLLOW
THIS INSTALLATION PROCEDURE STEP BY STEP !!! DO NOT ATTEMPT TO SKIP STEPS OR CHANGE THE
ORDER UNLESS SPECIFICALLY INVITED TO DO SO IN THE INSTRUCTIONS

STEP 1 : OPERATING SYSTEM SETUP

PCs:

- If you are running Vista, turn off the User Account Control (UAC) - to find it, you can go into Control
Panel and just search for “UAC” or “User Account Control”, then just uncheck the box. Then go to Step 2.
- If you are running Windows 7, disable the Administrator Control Settings then go to Step 2.

- If you are running Windows XP, go to Step 2.

MACs:

If you are using a MAGC, it is recommended to run Windows XP through either Bootcamp or VMware,
which Lightsolve users have been successful with (it may be possible to get Lightsolve to work directly
on a MAC but it will probably require some folder and paths settings that were not tested). You will then

have to install and access the Lightsolve program files (e.g. renderings) through those programs too.
Note: The main difference between the two is that with Bootcamp, you need to shut down and restart your computer to get
from the MAC OS side to the Windows XP side so you can never have both running at the same time. With a VMware fusion,
you can run Windows through MAC OS as a set of Windows and can have both computers run simultaneously (thus more
convenient but allows you less operating power for each).

STEP 2 : SKETCHUP INSTALLATION

Currently, ONLY the free 7 version of Sketchup (and the Pro 6 or 7 version) have been tested to work
with Lightsolve. Do not attempt to make it work with Sketchup 8 or higher. If you DO already have a
version of Google Sketchup installed and it is NOT the version 6 or 7 (you have Sketchup 8 for example),
you will have to uninstall it and re-install Sketchup 7. Lightsolve won’t work on other versions.

If you have to uninstall yours first, and once the uninstall is complete, also erase anything related to
Sketchup (or Lightsolve) in:

C:/Documents and Settings/your_username/Application Data/...

C:/Documents and Settings/your_username/Local Settings/Application Data/

before you reinstall Sketchup 7 using the install file below.

If you already have Sketchup 7 or Sketchup Pro 7 (or 6) installed on your Windows OS, check that it is
installed at C:/Program Files/Google/Google SketchUp 7 (or 6). If it is not, Lightsolve may not work
properly and you should re-install it.

If you DON'T already have Google Sketchup installed on your computer, download Sketchup 7 from:
http://web.mit.edu/mand/Public/Sketchup/GoogleSketchUpWEN.exe. Make sure to accept the default
installation path for Sketchup i.e. C:/Program Files/Google/Google SketchUp 7.

For MAC users, this is a Windows version so you have to install it through your VMware or Bootcamp,
NOT through your MAC OS.
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STEP 3 : SKETCHUP INITIAL SETUP

If you are using the free version of SketchUp (Google Sketchup) do as follows:

1) Open SketchUp and (if asked) choose the Basic Template in Millimeters.

2) Go to ‘File’ > ‘Export’ = ‘3D Model...’

3) If the button in the lower right marked “Options...” is enabled, click on it. (if not, Cancel and CLOSE
Sketchup then go to step 4).

3) Make sure “Triangulate all faces” is CHECKED

4) Click “OK” and cancel out of the export

5) CLOSE Sketchup.

If you had Sketchup Pro 6 or 7 already installed on your computer, follow these instructions :
1) Open SketchUp and go to ‘File’ > ‘Export’ = ‘3D Model...’

2) In the window that pops up, change the “Export type” to “OBJ"

3) Click the button in the lower right marked “Options...”

4) Make sure “Triangulate all faces” is CHECKED

5) Make sure “Swap YZ coordinates (Y is up)” is CHECKED

6) Click “OK” and cancel out of the export

7) CLOSE Sketchup.

STEP 4 : ADOBE AIR INSTALLATION
Download and install Adobe Air, Available from the website: http://get.adobe.com/air/

STEP 5 : LIGHTSOLVE INSTALLATION

Download and install Lightsolve, available from:
http://daylighting.mit.edu/publications/LightSolve 20100518.air
Reminder: Sketchup has to be closed before installing Lightsolve.

You should not see a zip file when you download the executable in this sequence, but an ‘air' file. It
seems Windows replaces 'air' extensions with 'zip' if it does not find the Adobe Air program. If you do
see a zip file but have Adobe Air installed, try to rename the extension to ‘air’. Then you just need to
double-click on the file and the installation process will start.

You have to allow the installer to place LightSolve in C:/Program Files i.e. the default installation
location. This is essential for the LightSolve files to be stored and found properly. You should also accept
all the other default settings (Run Lightsolve after installation and Lightsolve Icon on Desktop)

Afterwards, you will be asked to determine the path to the Plugins (including Lightsolve Plugins) folder.
The default one proposed will be C:/Program Files/Google/Google SketchUp 7/Plugins. If you have a 6
version of Sketchup (Pro), make sure to specify the right path.

During installation, you will be warned that your other Plugins will be erased. This actually only applies
to previous Lightsolve Plugins. But it is never a bad idea to make a copy of your other Plugins first,
should something go wrong with the installation.

At the end of the installation (after a white window opens and freezes but ultimately disappears), the

Lightsolve interface should open. If this doesn’t happen, there was a problem with the installation.
After you checked that the interface works properly, close it.
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STEP 6 : SKETCHUP PLUGINS SETUP

If you had Sketchup Pro already installed on your computer, skip to Step 7.

If you are using the free version of SketchUp (Google Sketchup), download the following zip file:
http://daylighting.mit.edu/publications/LightsolveFilesFreeSketchUp.zip

and extract the two included files as follows:

1) save su2objmtl.rb in C:/Program Files/Google/Google SketchUp 7/Plugins

2) save LightSolve.rb in C:/Program Files/Google/Google SketchUp 7/Plugins/Lightsolve
IMPORTANT : This version should copy over the one already in there !!!

STEP 7 : TEST YOUR INSTALLATIONS

Test LightSolve plugins installation:
* Open SketchUp after installing everything. On the menu, under “Plugins”, there should be a
dropdown list of choices starting with “Render and run Lightsolve” and ending with “Reload all”.
* If these do not exist, there is something wrong with the LightSolve download.

Test the LightSolve rendering engine:

* Example files have been installed on your hard drive, in the LightSolve Plugins folder
(C:/Program Files/Google/Google SketchUp */Plugins/LightSolve® if you kept the default paths).
The files are called “Testmodel_pro*” and “Testmodel2_pro*”*. Choose a model prior or equal
to your Sketchup version and open it in SketchUp.

* Click on Plugins = Interactive render

¢ Click ‘OK’ on all popup box defaults, until it asks you to chose a weather file, at which point,
open “Boston.wea”

* A white screen should appear and start reconfiguring a mesh of triangles making up the model.
After this disappears, a black screen and gray interface will appear, and after a few seconds,
your model should appear rendered in the screen.

¢ If this does not happen, your computer may not be able to handle the graphics of the rendering
engine.

¢ If a model does show up, but something is obviously wrong with it, check the export settings
listed in step 3 of this section.

* The model may be dark, but you can change the exposure under the “Lighting” tab on the gray
interface. You can move around the model by using your mouse (see Chapter 1, Exercise 2,
sections d & e).

LAST STEP : SEND US FEEDBACK

Whether you are satisfied with Lightsolve or not, we would very much appreciate receiving your
feedback. Please fill out the form available at:

http://daylighting.mit.edu/publications/LIGHTSOLVE FEEDBACK.doc

and let us know what your experience is or was working with Lightsolve so we can make it better suit
your needs and expectations. Thanks in advance and enjoy!

! Note that an earlier version of this tutorial, named LIGHTSOLVE_INSTRUCTIONS_2010- 05.pdf will automatically be saved in this same
Plugins/LightSolve folder: you can discard that version and only rely on the present document and on the updated tutorial named
LIGHTSOLVE_TUTORIAL_2010-05.pdf.
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1. Exploring the Program

This section will guide you through some simple exercises:

Exercise 1: Explore an Example Model in SketchUp

Exercise 2: Run an Example Model using the Interactive Render Feature
Exercise 3: Create Views and Run Lightsolve

Exercise 4: Explore the Lightsolve Interface

Exercise 5: Build a Lightsolve model in SketchUp

Exercise 1: Explore an Example Model in SketchUp

a. Find and open the example model: Testmodel_pro7.skp

The example model has been installed with the Lightsolve files into your Google SketchUp Plugins folder.
Find it here (if you are using SketchUp Pro 6, use Testmodel_pro6.skp):

C:/Program Files/Google/Google SketchUp 7/Plugins/Lightsolve/Testmodel_pro7.skp

NOTE: You can run the same set of exercises with the other example model (Testmodel2_pro*.skp), that
includes two rooms and a more complex glare situation but with fewer sensors (thus will run faster).

# Testmodel_pro7 - SketchUp Pro

Fle Edt View Camera Draw Tooks Window Plugins Help

P /ZBOC CRBLESE H2AR QLD EF VPO 99O

O ® © @ pragtoorbit. shift = Pan Measurements

b. Explore the model.

The example model is a classroom with shaded windows on one end of the space and skylights on the
other end. Sensors are modeled inside the space to represent a blackboard, a work plane, and the
possible viewpoints of the students and teacher.

Get familiar with the model by doing the following:

- Scroll around the model.
- Show how to “hide” and “unhide” faces in the model.
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- Look at the various materials used by selecting a face, right-clicking, and selecting “Entity Info” (see
image below). Refer to section 4 for more details about materials.

- Locate the illuminance sensor locations, including visible sensors (blackboard) and invisible sensors
(work plane). Locate the glare sensor views, including students and teachers. Refer to section 3 for more
details about sensors.

Entity Info [8]] Choose Paint
a

Layer: Lavero -
Area: | 8640 Inches 2 SENSOR_SWblackboard

|

f_ Hidden [V Cast shadows
[V Receive Shadows

e |
Cancel

c. Explore the Lightsolve pull-down menu.
Go to the Plugins menu. If you have installed Lightsolve, you should see options starting with “Render
and run Lightsolve”. If you do not see this menu, there is a problem with your Lightsolve installation.

[ Plugins | Help

Render and Run Lightsolve

Interactive render

Run LightSolve Interface

Cull backfaces

Fix backfaces

Populate Glare Zones with Sensors

Reload all

d. Try the “Cull backfaces” and “Fix backfaces” options

Use the “Cull backfaces” option in the Plugins pull-down menu. This option allows you to see through
the backs of faces. The fronts of faces look opaque. Your example model should look like the image
below.

Return faces to normal by selecting the “Fix backfaces” options in the Plugins pull-down.
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¢ Testmodel_pro7 - SketchUp Pro

Fe Edt View Camenn Draw Took Window Plugin Help

V| ZBOC CURBLESEFHZARAILD €F WAWVN99S

(@) @ © | (@ select objects. shift to extend select. Drag mouse to select multiple. Measurements

Exercise 2: Run an Example Model using the Interactive Render Feature

a. Select “Interactive render” from the Plugins pull-down menu.

[ Plugins | Help

Render and Run Lightsolve
Interactive render

Run LightSolve Interface

Cull backfaces

Fix backfaces
Populate Glare Zones with Sensors

Reload all

b. Select number of triangles for mesh.

Type in the number of triangles you wish to have for your model re-meshing. We will use 500 for faster
renderings. You can also select a higher number of triangles for greater accuracy. Keep the “View
Mesher” response as the default “yes”.

1 Meshing Information g
Number of Triangles
View Mesher yes

oK |  Concel |

You should see the remesher begin. Your model will look something like the image below as it
remeshes.
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c. Select your location and weather data.
Keep the default location of Boston, MA for this example case. Select the Boston.wea weather file from
the list of .wea files.

@ Please select the associated wea file S
Lookin weather - e B3
Neme Date modified  Type Size
i
¥ AddisAbaba & Bangkok
Recent Places o e
¥ Boston @ BostonLogan
[ (T & Hongkong
Desktop & London & LondonGatwick
T ¥ Osaka & Philadelphia
 Phoenix ¥ Singapore
L & StPetersburg & Sydney
Computer
=
Network
Fie name Boston ~ Open
Files of type: ~] Cancel

d. View the model using the Interactive Renderer.

& Jeygdrive/c/PROGRA~1/Google/GOOGLE~2/Plugins/Lightsolve/Isv

You should see two boxes, one which
contains the rendered image of the
model and one which has controls.
The rendered image will look like this:

You can move around the model using
the following controls:

Right mouse button — zoom in and out
Left mouse button — rotate

Middle mouse button — translate
(similar to the “hand”)
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e. Explore the model and controls in the Interactive Renderer.

Try changing the time of day, day of year,
brightness, exposure, and sky type. Your rendered
image should update automatically as your change
these variables.

 Indirect lllumination
 Shadow Volumes - direct only

C PolyText: Material ™ Draw samples on windows
 PolyText: Physical Material [~ Draw sky rays

& Shadow Volumes + indir + sky +emis ¢ PolyText vill [ Draw sun rays
Highlight ID |0 -  PolyText: viiZ2
218 El  PolyText: vIDV
 PolyText: viD

f. Close the Interactive Renderer and return to SketchUp.
Close the Interactive Renderer by closing the DOS window that says “C:\Windows\system32\cmd.exe”

Exercise 3: Create Views and Run Lightsolve

a. Create views using the camera icons.

 PolyText: SunLit Percent
@ VerText: None
C VerText: ID

Lightsolve allows you to create three views to be rendered. To create a view, rotate your model in
Sketchup until you are satisfied with the current view. Then, click one of the three Camera buttons.
Store three separate views by clicking each of the three Camera buttons once. Please note that you

should only create interior views for renderings.

For more information about views, please see section 5.

PRV ]

2. Review your saved views.

< alview toolbox 2 ) |
Input +]
{Ligfiting Options —|
time of day[125341 2| 4] | |
day of year[80 Bk} Bl |
lights brightness[10 2] 4 I
Exposure [ 0.5 =
¢ Sun only (black sky) @ Black Ground
& CIE Clear Sky  Green Grass
¢ CIE Clear Sky - Turbid  Cement
¢ CIE Overcast Sky (no sun)
¢ CIE Uniform Sky (no sun)
¢ CIE Intermediate Sky
Animation for a whole day | Grab images |
Visualization Options =
 no triangles @ PolyText: None [V Cull back-facing polygons
 Simple Materials  PolyText: ID ™ Draw Wireframe
 Physical Materials C PolyText: Area ™ Draw Normals
 Radiosity direct only(sun)  PolyText: FFSum [V Draw Per-Vtx Rad. Color
¢ Radiosity direct only(sky+emis) ¢ PolyText pFFSum [~ Draw Invisible Sensor
 Radiosity direct only(s ky  PolyText: FFMapSiz: ™ Draw Extra parts
 Radiosity ¢ PolyText: Pass/Material ™ Draw Filln parts

To review a saved view, click on the Eye buttons. Each Eye button corresponds to a numbered view. If
you wish to change a view, simply create the view again using the appropriate Camera button.

Plugins | Help

3. Run Lightsolve
When you are satisfied with your views, select “Render
and Run Lightsolve” from the Plugins pull-down menu.

oMIT

Render and Run Lightsolve
Interactive render

Run LightSolve Interface

Cull backfaces

Fix backfaces
Populate Glare Zones with Sensors

Reload all
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d. Accept all default values.
For this exercise, accept all default values:

- We will consider our goals for all times and seasons, so all values in the goal times interface are
“yes.”

- The default illuminance goal ranges for all iluminance sensors are 100-300-1500-2500. This
means that the performance objectives for illuminance are to have at least 300 lux on the
sensor planes and at most 1500 lux (full goal achievement credit), with partial credit given down
to 100 and up to 2500.

- The default glare tolerance is “medium” for all glare sensors (recognition of ‘disturbing’ glare).
Refer to section 6 for more information.

As before, keep Boston, MA as the location and select the Boston.wea weather file. For further
information about creating a new weather file, refer to section 5.

Tlluminance Goals for SENSOR_SWhblackboard &J

Acceptable High (lux) l”-’»ﬁﬂl

Preferred High (lux) ‘1500

|
|
Preferred Low (lux) |3UU ‘
|

Acceptable Low (lux) |1 00

OK Cancel |
f Glare Tolerance for INVISIBLE_SENSOR_GLARE_students1 &J
Glare Tolerance for INVISIBLE_SENSOR_GLARE_students1 |[[15: 1111 '~

oK Cancel

Change the default exposure from 0.5 to 0.3 to get less saturated images in this particular model (a good
exposure value can be determined by exploring different times and dates with the interactive renderer
and will depend on viewpoint and model — but you will probably always have some saturated and some
darker images because of the great dynamic of daylight)

If you change the default value from “no” to “yes” in the box that asks “Include Solar Gains data”, you

will have to go through questions relevant to solar gains calculations. Refer to Appendix 10 for
information about relevant solar gains input.

Model Information &‘J

Exposure ll].5 I

Run Interface this time? IYeS I

Include Solar Gains data? ‘YCS |

OK | Cancel ‘

e. Wait for the renderings to be created and for the interface to open.
You should see renderings being created on your screen in real time. Once the renderings and temporal
maps are completed, the Lightsolve interface will open.
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Exercise 4: Explore the Lightsolve Interface
For more information about the lightsolve interface and its functionalities, please see section 7.

a. Explore the Temporal Maps and Renderings View.

You should see three types of temporal maps (color plots): illuminance, glare, and solar gains. The
example model includes two illuminance maps (SE and SWblackboard), two glare maps (students and
teachers), and one solar gains map.

To get familiar with the interface functionalities, you can:

- Explore renderings from different times of year by moving cursor over temporal maps.

- Save images of maps and renderings by right-clicking of the image and selecting “Save this image.”

- Change the sky type for the viewed renderings by clicking the “Weather” menu and selecting a sky type
from the pull-down (the default is an automatic selection based on climate).

- View animations over a day or year by using the menu in the lower left corner.

LightSolve ESEEl ™)

File Model: Testmodel_pro7 View: Temporal Maps / Renderings Weather: Weather by climate (auto)

Intermediate

35%

Overcast

SENSOR_SWhlackboi v 7 X

10pm

1: View 1 v ?7 X 2:View 2 MEIR

M EEE
B —

3: View 3 v ?7 X

TIME

sunrise

<«
d
2
m
»
o
5
m

morning

late spring

early summer

late summer - - .
afternoon

early fall GLARE_students1 v ? X

late fall avening 10pm

sunset

+ rende

' now viewing: May 29, 9:53 am Overcast Sky (by local climate

The temporal maps show you when, over the whole year and accounting for the local climate, your pre-
set sensors achieve (yellow), exceed (red) or are below (blue) the prescribed performance goals for
illuminance and glare and when solar gains are likely to be excessive (red), beneficial (yellow) or
insufficient (blue) to help keeping the space comfortable.
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b. Explore the Annual Image View.

You can test out the following functionalities:

- Change the view using the pull-down in the upper left corner.
- Enlarge an image by scrolling over it.

- Save an image by left-clicking on it.

- Change the sky type for the viewed renderings by clicking the “Weather” menu and selecting a sky type

from the pull-down (the default is an automatic selection based on climate).

LightSolve

E

[File  Model: i;ﬂmodeljvo7 View: Annual Image View Weather: Intermediate

sunset

B’ EFEE

HH

: HB

'HH

FIHB
FEEH

afternoon

I'HEH

- --a -

g - - L -a-a
8 |

— . e (—

| | | I | I -m e
g a—— - [EE———
s —
€

- - - --a --a - -—-

A S A — s A e "R &

sunrise

Eie. s ki ke i

January February March April May June July August September October November December

now vieving: April 13, 1:51 pm Tntermediate Sky (manual

Exercise 5: Build a Lightsolve model in SketchUp

For more information about modeling in Sketchup for Lightsolve, please see sections 2 (Model
Geometry), 3 (llluminance and Glare Sensors), and 4 (Materials).

a. Build a massing model (no windows yet).

Create a 2d footprint using the Line or Rectangle tools. / B

Use the Tape Measure tool to create construction lines if needed.

<

Extrude to desired height using the Push-Pull button.
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[ Untitled - SketchUp Pro. e

Fie Edt View Camera Draw Tools Window Plugins Help

V/BOC CGRB LASF HLARA LS EF WARAIIS

@) orag in direction to pan Measurements
OO0 @0

¢ Untitied - Sketd
File Edt View Car

wa )

aw Tools Window Plugins Help

JIRBLESEH2ZARADUD EF WAV 3D

<

© @ © | @ 0ragto push or pul face or enter valve. Ctl = taggle create new sarting face. Distance 10

b. Reverse back-faces so that the interior facing surfaces are considered “front.”
Select all faces in the massing model, right-click, and select “Reverse Faces.” Double-check to make sure
they are correct using the “Cull backfaces” option from the plugins pull-down.

c. Specify materials for opaque faces.
Use the paint bucket button and change the color of the walls, floor, and ceiling. These can be any
color. Make sure that both sides of each face have the same material.

See section 4 for detailed information about materials and how to specify them.

d. Create windows.
Use the Tape Measure, Pencil, and/or Rectangle tools to draw windows where desired.
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JBOC - G9BLHOE HLARILS €H MARAIIS

\\ P

D © | @) select objects. Shit o extend seect. Drag mouse to select muliple

e. Create a glass material and add to windows.

Create a new material for the glazing. The name of this material must contain the word “GLASS” (all
uppercase), for ex. “GLASS_SouthWindows”. Specify the transmissivity of the glazing by changing the
opacity in the Materials menu, for ex. 20% is equal to 80% transmissivity.

See section 4 for detailed information about materials and how to specify them.

¢ Example model fo exercises handout - SketchUp Pro =83 Materials

A
VN /ZBOC v g RPBLESEF HZARILDEF WAWASD [GLasS_Southiindows O
B od
od
= 2 Select Edit Z2
poker: [oorwnes =] of Color

[ ——— ,
Picker: |Color Wheel | " =]

Texture

Q\ = .

" Use texture mage

© @ © | @ selectobjects. s to extend seect. Drag mouse to select multple Measurements

f. Create illuminance sensor planes and illuminance sensor materials.

Use the Tape Measure, Pencil, and/or Rectangle tools to draw 2d sensor planes where you are
interested in finding illuminance in your model. These sensor planes should only be located inside your
model. They can be horizontal or vertical. Use the cull backfaces tool to ensure that all sensors are
facing up (for horizontal sensors) or facing the correct direction (for vertical sensors).

Create a new material for each individual sensor plane. The name of this material must contain the
word “SENSOR” (all uppercase) for opaque sensors or the words “INVISIBLE_SENSOR” for non-opaque
sensors, for example “SENSOR_SouthZone” or “INVISIBLE_SENSOR_SouthZone”. If the sensors are to be
invisible, make sure to set the opacity of the material to 0%.

The image below shows an example of a horizontal illuminance sensor (in red) in a model.

See sections 3 and 4 for detailed information about sensors, sensor materials, and how to specify them.
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Fie Edt View Camen Draw Tools Window Plugins Help

' /BOCICYRBLRSEFH AR LD EF WPV IIIS

O ® O @ select object to match paint rom Measurements

g. Create glare sensors.

Use the Tape Measure, Pencil, and/or Rectangle tools to draw 2d sensor planes where you are
interested in finding glare in your model. These sensor planes should only be located inside your model.
Use the cull backfaces tool to ensure that all sensors are facing the correct direction.

Create a new material for each individual sensor plane. The name of this material must contain the
words “SENSOR_GLARE” (all uppercase) for opaque sensors or the words “INVISIBLE_SENSOR_GLARE”
for non-opaque sensors, for example “SENSOR_GLARE_SouthView” or
“INVISIBLE_SENSOR_GLARE_SouthView”. If the sensors are to be invisible, make sure to set the opacity
of the material to 0%.

The image below shows an example of two glare sensors (in blue) facing south in a model. See sections 3
and 4 for detailed information about sensors, sensor materials, and how to specify them.

¢ Untitied - SketchUp Pro STTX

File Edt View Camers Draw Tools Window Plugins Help

' /BOC VY RBL RSV 2ZARILS 8F WAWILIID

@ @ © | @ select objects. shift to extend select. Drag mouse to select multple. Measurement ts

h. Create views.
Refer to section 1 (Exercise 3, part a) or to section 5.

i. Run Lightsolve.

Once you have created your model and specified views, you are now ready to run Lightsolve with your
own parameters and goal values. Please refer to the relevant sections in this tutorial for this. We advise
everyone to try to run the Interactive Render tool first before attempting a full render. If the model
does not seem to run correctly, please refer to the troubleshooting guide in section 8.
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2. Model Geometry (using Google SketchUp)

This section describes critical rules to apply while making your Lightsolve models in SketchUp.

All models must be "watertight".

* For example, if the model was filled with water, none would leak out. This means you
cannot leave windows or doors open, but you must fill them with glass. If your design
requires open apertures, you can fake this condition by using a “glass” material (see
Material Names section) with 100% transmissivity.

Planes may not cross or form a “T” junction.

* This is annoying, especially when dealing with
louvers, but the remesher cannot currently handle
intersecting planes. To the right is a picture of plane
intersections that cannot occur in your model. Single
planes inside your watertight space can be used for
things like sensors, but they must be free-floating or
part of the wall or floor itself.

It is best to make single-plane rather than solid walls.

* Thisis first because the inside of your space is basically all that matters, and second,
because it vastly reduces the number of triangle patches necessary to make up your
model, making it much less likely to crash the remesher.

* If you wish to make window sills with some thickness, you can pull the window
outwards from the building. This creates the same effect, as far as daylighting is
concerned, as having walls with thickness. See picture below.

The normals of the planes in your daylit zone(s) must face inwards.
* You can check which way normals are facing by clicking on "Plugins" = "cull backfaces".
In this setting, you only see planes that have the normals facing you. To put the
backfaces back in place, click "Plugins" > "fix backfaces". This will automatically make
the backface material the same as the frontface material. Backface materials won't have
anything to do with the rendering.
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* Below is an example building which works with the remesher and rendering engine,
seen from the outside and with culled backfaces. Not only are all normals facing
inwards, but rooms completely separate (solving the crossing-planes problem above),
the sensor planes are free-floating, and there is glass in every window. In this example,
the separate rooms were made by creating a single volume, drawing wall outlines on
the ceiling, and push/pulling the division all the way to the ground.

Your model does not have to be a box.
* Room and floor partitions can be made in the same way as the example above, as can
columns and other interior objects.
* Interior partitions can be created in the same way as walls between rooms. Draw the
partition on the floor and push/pull it only part way to the ceiling, like in the rendered
examples below.

* Segmented curves (such as any curve made internally in SketchUp) work fine, such as
the two simple examples below of a subway tunnel and a curved room.
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Currently, you cannot have any separate planes attached to the outside of your zone.
* Forinstance, if you wish to make a shade, you should make a full box, then move it
maybe an inch away from the side of the building.
* Alternatively, you can pull a thin section of your wall out to form the shade. In that case,
you can leave the normals as they are. See examples below. There is a free-floating
overhang on the left, and one that was pulled from the wall on the right.

* Similarly, the easiest way to make louvers is to push/pull the part of the window
between the louvers, as shown below (left: SketchUp model, right: rendering).

* |f you have any external objects not attached to your main lit zone, they should have
normals which are facing OUT, should be a watertight structure, and should be labeled
with an EXTERIOR material tag (see Material Names section).

Explode imported components.
* |f you import another SketchUp file into your model, you need to explode the

component before it will work with the rendering engine. Just right-click on the
component and choose “Explode” from the menu.
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3. llluminance and Glare Sensors

Sensors in Lightsolve are planes, not points.
* To create a sensor plane, simply model a 2D plane. These can be vertical or horizontal.
* Normals should point towards the direction you wish to analyze, similar to a luxmeter.
For example, horizontal illuminance sensors typically face upwards.

llluminance sensors

* Illuminance sensors can be opaque surfaces (such as a wall or desk) or “invisible”.

* To use anilluminance sensor, the user will need to specify an illuminance goal range for
that sensor plane. The calculated result will be the percentage of the area of that
sensor that sees illuminance within the specified range for a certain period of time.
Lightsolve will calculate these values automatically for the whole year.

* [ftwo or more illuminance sensors have the same name, calculations will be performed
over the total area of all sensors with that name. Typically, we want to name each
illuminance sensor by a different name.

Glare sensors

* Glare sensors can be also be opaque or “invisible”. However, because we would
typically like to find glare from an occupant viewpoint, we will almost always use
“invisible” sensors for glare.

* Users need not specify a goal for glare. Lightsolve will automatically calculate the
Daylight Glare Probability (DGP) for all glare sensors and determine the percentage of
the sensor area of glare sensors with the same name that sees glare (using DGP
guidelines).

* To get ageneral idea of the glare over an area in the space, it is recommended to model
many small boxes at occupant head height (sitting or standing) with planes facing the
directions in which you are interested. The creation of these boxes can also be
automated (see next paragraph).

Automated glare sensor box creation
[CAUTION: This feature is still under development. If it does not work for you, you can still
create glare sensors manually.]
* To automatically create glare sensor boxes, model a “glare zone” as a horizontal 2D
plane at occupant view height in the area you are interested in.
* Change the material name of the plane to “GLARE_ZONE_<anyname>" (see section 4
for more information about naming conventions for sensors and windows).
* Go to “Plugins” > “Populate Glare Zones with Sensors.”
* You should see small boxes populated in a 3ft by 3ft grid within the area of your glare
zone plane (see image below).
* Delete the 2D glare zone plane.
* If you would like to model additional glare zones, simply name the additional glare zone
material a different name (ex. “GLARE_ZONE_1" and “GLARE_ZONE_2").
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NOTE: There are no sensors to create for solar gains results. See section 6 for input needs.
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4. Materials

There are two ways to define materials for Lightsolve : directly in SketchUp or through the
Lightsolve materials library. For almost all regular materials, you should define directly through
SketchUp. For translucent windows, you should use the materials library.

Defining your materials in SketchUp.

Any surface can be assigned a material by right-clicking on the surface and choosing
“Entity Info”. Click on the swatches of color to change or edit the backface and
frontface materials. Only frontface materials matter to the rendering engine, so it’s
usually easiest to make both swatches the same.

To edit a material, highlight that material swatch in the list and click “Edit”. The material
editing interface should pop up.

Edit Material Edit Material Edit Material

Material_Name Material_Name Material_Name
A 4 7]
Color Color Color

Picker: |Color Wheel v Picker: |HLS v Picker: |RGB v
H _ o = R 236 -+
o } l s 100 ¢ 1N 167 =
- . — [r 2 ° w =

Texture
[ Use texture image

Texture

I Use texture image

Texture

I Use texture image

| | g |l 2
T s F . F T g F
[ Reset Color [T Reset Color [ Reset Color
Opacity Opacity Opacity
[100 =] 100 = 00 =
Cancel | ok | cancel | ok |

Cancel |

The top right box is the material name.

The “Picker” offers you several ways to define the color and reflectivity of your material.
The number closest to the total reflectivity of the material is “L” in the HLS method.

For GLASS: The transmissivity of any material is 1 minus opacity. If it is 100% opaque, no

light gets through (like a wall), and if it’s 20% opaque, 80% of the light gets through (like
a window).

Defining your materials in SketchUp : Special Material Names

oMIT

For the materials below, replace <anyname> with whatever series of letters or numbers
you wish.

Glass materials should be named "GLASS_<anyname>". They should also be given some
transparency by sliding down the opacity in the materials editor.

Illuminance sensor planes that you wish visible should be named "SENSOR_<anyname>"
and assigned a 100% opacity value. You can make an opaque material like a wall into a
sensor in this way.
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Illuminance sensor planes that you wish to be invisible (and thus not affect the light
distribution) should be named "INVISIBLE_SENSOR_<anyname>" and should be
assigned a 0% opacity value.
Glare sensors should be named “INVISIBLE_SENSOR_GLARE_<anyname>" and assigned
a 0% opacity value (unless for some reason the user wants the glare sensor to be visible,
in which case it should be assigned a 100% opacity value and be named
“SENSOR_GLARE_<anyname>”). If the glare sensors were created using the automated
method described in section 3 and based on a GLARE_ZONE_<anyname>, they will
automatically have their four vertical surfaces facing due East, North, South and West
be assigned the following materials:

o INVISIBLE_SENSOR_GLARE_East_<anyname>

o INVISIBLE_SENSOR_GLARE_North_<anyname>

o INVISIBLE_SENSOR_GLARE_South_<anyname>

o INVISIBLE_SENSOR_GLARE_West_<anyname>

and have 0% opacity.
ALL objects external to the daylit zones should have outward-facing normals and MUST
be named “EXTERIOR_<anyname>".
You can make multiple Sensor or Glass materials.
Separate sensor materials (i.e. named differently) will have separate temporal maps
made for them.
Multiple planes with the same sensor material name will be grouped together into a
single temporal map.
For solar gains calculations, you should name external walls “EXTWALL_<anyname>”,
which will allow the external wall area to be totaled automatically. For similar reasons,
external roof materials should be called “ROOF_<anyname>”, and materials which
contribute to the total floor area of the space should be named “FLOOR_<anyname>".

Using the Lightsolve materials library

oMIT

The Lightsolve materials library contains pre-made material definitions for a number of
different material types, mostly glass. It is called “material_database.lsvmtl” and is
located in the Lightsolve folder in the Plugins folder in the Google Sketchup program
files. You can view and modify this file using a text editor (like Notepad). Please note
that this file must stay in the Lightsolve folder for the renderer to work.
A large number of glass types have been pre-defined. You can easily use these by
defining your glass material names in the following way:

o The form of the material name should be “GLASS_Sx_Dy”, where:
X is specular transmissivity
y is diffuse transmissivity (translucent materials)
x and y must be defined in increments of 5%
The total transmissivity (x + y) must be between 5% and 90%
For example, GLASS_S35_D45 is 80% transmissive where 35% is specular
transmissivity and 45% is diffuse transmissivity
If the material you wish to use already exists in the library, use the name of that
material in your SketchUp model and the material definitions will automatically be used
by the renderer. For example, “FABRIC_SHADE” is a pre-existing material that defines a

O O O O O
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white fabric shade that has 2% specular transmissivity, 5% diffuse transmissivity, and
30% diffuse reflectivity.

If you wish to define your own material, you must open the “material_database.lsvmt|”
file, add the new material definition, and save the file. Then use the name you specified
in the database file in SketchUp. Use the format described in this document to specify
material properties: http://qraphics.cs.rpi.edu/daylighting/Isv/Isvmtl_readme.html
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5. Views and Location Settings

Setting Camera Views in SketchUp

These buttons i ' g g ' i '3 5 should be on the toolbar in

SketchUp. If you do not choose views, views corresponding to various orthogonal
directions will be selected automatically.

To store the current view in SketchUp, click on one of the camera buttons. You are
allowed to store 3 different views.

To revisit a stored view, click to the eye buttons.

NOTE: Unfortunately, those views cannot be saved in the Sketchup model at this point and
have to be reset if the model is closed.

Setting Location, Climate, and Orientation in SketchUp (for LightSolve)

Download the .epw weather file closest to your site from the Energy Plus Weather Data
website: http://appsl.eere.energy.gov/buildings/energyplus/cfm/weather data.cfm
If there is no weather data that is close by, select a weather file as close to the same
latitude and climate type as possible, even if it is many miles distant.

If you put this file in the SketchUp plugins folder (file folder
.../Plugins/LightSolve/weather), you will not have to browse for it when you create your
new LightSolve weather file.

=

This button R should be on the toolbar in SketchUp. It will ask you for a name for
the weather file (no spaces!). It will then ask you to select the Energy Plus weather .epw
file to be converted. If you did not place the Energy Plus file in the folder described
above, you will have to browse for it. When you select the Energy Plus file, the process
is complete, and a new weather file should then be in the LightSolve weather folder.
You can change which direction in your model is north by going to "Window" - “Model
Info” = “Location” and changing the “North Angle” setting. If you wish to see the north
angle in the model, check “Show in Model”, and it will appear as an orange line. (You
don’t ever have to change anything else on that page for use in LightSolve.) NOTE: this
angle offset will not show up in Interactive Render, but will in Full Render (see section
6).

OMIT
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6. Remeshing, Calculation parameters setup and Rendering

Remeshing process

* The remeshing process triangulates your model so that the renderer can function. The
“Meshing Information” popup will ask you for a target number of triangles. The
remesher can handle more than 3000 triangles, but not too much more (this will depend
on your computer memory). Higher numbers of triangles will result in higher accuracy
but will take longer for the renderings to complete.

* If the program exits the remeshing process and returns to SketchUp, there is a problem
with the model. This is more common if the model was imported.

* Typical Issues... check to make sure that:

o All planes are facing the interior of the model (even one facing the wrong way
causes the model to crash)

o There are no stray or doubled panels or line segments as this could cause
degenerate or overlapping triangles

o The model is watertight

o Thereis at least one transparent surface, and the material name starts with
“GLASS_”

o There are no panels with the “<default>" SketchUp material.

o There are no intersecting surfaces (T-junctions and X-junctions)

o There are no floating planes on the exterior (only boxes)

* If you can’t find the problem...

o Run the “Interactive Render” again.

o When the Meshing Information popup appears, choose “control” in the
dropdown menu asking if you want to view the remesher. This stops the
remesher from opening, running, saving, and closing automatically.

o Hit the button that says “REMESH” in the grey interface.

o When the remesher finishes, orbit the model (you can also click the “cull
backfaces” button near the bottom of the interface) and look for red, cyan,
green, and yellow triangles or lines. These will show you where the problem
area is, and you can go try to rebuild that part of your model. A few tips here:

= Red means floating edges — it is OK around sensors or floating planes, or
around exterior elements

= Yellow often means there is a surface facing the wrong way, or there is an
extra line — it is BAD and will cause the remesher to crash

= Blue means bad neighbor triangles — it is usually OK, the remesher will fix
it

= Cyan means bad normal triangles — it is better to correct this but the
remesher may fix it on its own

o Click on “Quit” to exit the remesher and return to SketchUp to fix your model.

Running Lightsolve: Interactive Render Mode
* The interactive render mode allows the user to view the rendered model interactively so
you can change the model view and see a rendered image in real-time. It also allows
you to play with the exposure levels of the renderings for different times of the
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day/year. We highly recommend this as a first step so that you don’t waste time making
renderings that are too dark or too bright.

* To start, go to "Plugins" - “Interactive render”.

* In running the interactive render, just press “ok” for every popup box except the ones
dealing with location and the weather file.

* After the weather file is chosen, a screen should pop up with the model rendering in it,
and a grey GUI.

* You can move around in the rendering by using your mouse buttons to orbit and zoom.

* You can change the time, weather type, and rendering exposure under the tab marked
“Lighting”.

Running Lightsolve: Full Render Mode

* Go to “Plugins” = “Render and Run Lightsolve”.

* The first popup window will ask the approximate number of triangles to use in the
remeshing process. The default is 1000, which is plenty for a single room, but if there
are multiple rooms or many smaller surfaces, you may need more. The popup will also
ask if you’d like to see the remesher:

R o) “ves” will allow you to see the remeshing process,
p— but run it automatically. “no” will hide the remesher,
Number of Triangles [ ”o
I” will open the remesher, but you must

and “contro

View Mesher run it yourself.
OK I Cancel |

* After the remeshing completes, if there are illuminance sensors in your model, a
window will pop up for each illuminance sensor material asking for the desired
illuminance goals for that surface. It gives you the option to give a desired AND an
acceptable range (illuminances between the acceptable and desired numbers will be
given partial credit, weighted by how close it is to the desired illuminance). The
“acceptable” low must be less than or equal to the “desired” low, and the “acceptable”
high must be greater than or equal to the “desired” high.

—_—

Tlluminance Goals for INVISIBLE_SENSOR_SOUTH [

Preferred Low (lux] |4l][I

|
Preferred High (lux] lBl]U I
|
|

Acceptable Low (lux) IZUU

oK | Cancel |

The choice of illuminance goals depends on the type and intended use of the space. As
an indication, research shows that most people will feel comfortable reading and
writing at 300 lux, and illuminance levels below 100 lux are somewhat consistently
considered insufficient for a workspace (but can be adequate for a corridor). Please
refer to the Lightsolve Metrics Appendix 9 for more information about how those
values are used to indicate daylighting performance in Lightsolve.
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e Similarly, if there are glare sensors in your model, a window will pop up for each glare
sensor material asking for which level of glare tolerance should be assigned to it
(“high”, “medium”, or “zero”). Zero tolerance sets the strictest glare-recognition
threshold, and considers “perceptible glare ” levels already as a maximum glare threat.
Medium tolerance recognizes “disturbing glare” levels as fully problematic, with partial
recognition for lower levels of glare, and high tolerance recognizes only “intolerable
glare” as really problematic, with partial recognition for lower levels of glare. Medium
tolerance is the default choice.

Refer to the Lightsolve Metrics Appendix 9 for more info.

Glare Tolerance for INVISIBLE_SENSOR_GLARE_students1 >3 '

Glare Tolerance [‘high','medium','zero’) |medium |

oK | Cancel l

* The next popup box will ask for: the exposure (see ‘Interactive Render mode’ section
above), whether to run the interface at this time, and whether to calculate solar gains.
If the interface is not run at this time (“no” answer to second entry), the data are saved
in the right place for a later use but the Lightsolve interface does not show up at the
end of the process. Answering “yes” to the question about solar gains will make popup
boxes appear for the solar gains metric, whereas they will be skipped if “no” is the
answer.

Model Information w

Exposure |[l.5

Run Interface this time? IVCS

Include Solar Gains data? |YCS|

oK | Cancel I

* |f a solar gains calculation is requested, the next popup box will ask for envelope
information. The solar gains metric is based on a simple balance-point calculation, but
to perform this calculation, some heat transfer material values are required. You can
find typical values for different climates, surfaces, and building types in the appendix at
the end of this tutorial (section 10). If you use the correct material names (see the
“Material Names” section), the floor, roof, and external wall areas should already be
totaled for you.
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Solar Heat Gain Information 1

Floor Area [m2]: |1 39.054134443784

Exterior Wall Area [m2]: |35-5225451035093

Exterior Wall U-value [W/m2K]: [0.477

Roof Area [m2]: |1 59.67423121992

Roof U-value [W/m2K]: |n.357

4 Ave Glass U-value [Wim2K]:  [3-24

|
|
|
|
|
|
|

SHGC for GLASS_80 |l].39|
OK I Cancel I

The second popup box for solar gains will ask for heat gain, ventilation, occupancy, and
operational information. These are meant to be ballpark numbers; again, refer to the
appendix for some suggested default values based on building type. All values for solar

gains should be given in Sl units.

Solar Heat Gain Information 2

Total Ventilation{Infiltration Rate [m3/s]: |0-0021
Occupants per floor area: |l].3
Equipment/Lights Heat Gain per floor area [W/m2]: |1 5
Occupancy Start Hour [1-24]): |8.l]
Occupancy Stop Hour (1-24]): |1 6
Occupancy Equipment percent: |1 .0
Non-occupancy Equipment percent: ||]-2
Heating occupancy Setpoint [F]: |69.l]
Heating non-occupancy Setpoint [F]: IBS.I]
Cooling occupancy Setpoint [F]: |72.[I
Cooling non-occupancy Setpoint [F]: |75-0|

,Tl Cancel [

The next popup box asks for the location of the model.
You can give the location a formal name and an
abbreviated name (choose any name with no spaces),
and you should enter the latitude, longitude, and time
zone. Latitude is positive for the northern hemisphere
and negative for the southern. Longitude is positive for
the eastern hemisphere and negative for the western.
Time zone refers to the number of zones plus or minus
GMT. For instance, -5 is the time zone of Boston.

|

|

|

|

|

|

|

| .

|

|

|

f Weather data L—&J

cy
City Abbrev
Latitude
Longitude 71

The final window asks you to choose a weather file. Please choose the file that matches
the longitude and latitude you just entered in the location box for accurate results.
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r B
Q Please select the associated .wea file [éj
Look in: weather _VJ & B~
L= Name Date modified Type Size
= AddisAbab @ Bangkok
Recent Places £ sAbabe .
¢ Boston @ Bostonlogan
! @ Harare @ HongKong
Desktop @ LondonGatwick @ Philadelphia
™ @ Phoenix @ Singapore
Wi @ StPetersburg @ Sydney
Jaime
Computer
:I
-
Network
File name: IBcston ﬂ Open |
Files of type: | ﬂ Cancel

Now, sit back while Lightsolve performs renderings and does calculations! When this is

finished, the LightSolve GUI should open automatically.
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7. The Lightsolve Interface

Opening the LightSolve GUI Without Calculations
* Go to “Plugins” = “Run LightSolve Interface”.
* Alternatively, a link directly to the LightSolve GUI should have been installed in the
Programs folder of your start menu, as well as a shortcut for your desktop.
* All previously rendered/calculated data is accessible from the GUI. You can access any
previous model by clicking on the “Model” tab and choosing from the dropdown menu.

Lightsolve Interface Features
* Model:

o Choose any model which has data currently stored in the

“My_LightSolve_Renderings” folder.
* View modes:

o Temporal Maps and Renderings: This view shows the active model’s temporal
maps and renderings. One map will be created for each illuminance or glare
sensor and the sensor’s name will appear in each one’s title bar (<anyname>).
One map will be created for solar gains if those calculations were run, named
‘Solar Heat Gain’. Renderings will be displayed on the right for the preset views.

o e S |

LightSolve

File Model: LightSolve_Example View: Temporal Maps / Renderings Weather: Weather by climate (auto)

’v'l “'V
L y
26% 19%

Clear Intermediate

L X

26% 28%
Clear-turbid Overcast

1: Top view -7 x

Dats Map 1 v ? X

T Level cuisice comer 7 x

SEASON TIME

late winter sunrise

el morning

«
=
E
m
»
o
3
m

late spring

3 insice view of window

[7x
+ renderin

PLAY SPEED
S ————————

temporal map +
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You can show and hide up to six temporal maps and/or renderings for the active
model by either right-clicking on the title bars or by clicking on the ‘temporal
map + or the ‘+ rendering’ buttons at the bottom of the interface. By default,
only three of each are shown. You can also resize temporal maps and renderings
by moving the vertical bar separating them to the left or the right.

By moving the cursor over any temporal map, the time of day and year will
change for all of the maps simultaneously and the series of renderings relevant
for that period of time will be displayed on the right. You can also see the
likelihood of different types of skies at each point in time and run animations
over a day or over a year (for a certain time) from this screen (screen shot
below).

Please refer to Appendix 10 (Lightsolve Metrics) for more details about the
information displayed on the temporal maps (the ‘?” button on their title bar also
provides some info).

o 3D Model: This view allows you to manipulate a meshed version of the model,
including invisible sensor planes. From this screen you can look at the model
from different perspectives including a view ‘from the sun’ (to visualize sun
penetration opportunities immediately). Press “Enter” to get rid of the
movement instructions (screenshot below).

You also have a functionality allowing you to choose new views to render, and
that will be saved with the model (unlike the ones set in Sketchup).

T e T
LightSolve - =G

[File  Model: LightSolve_Example View: 3D Model

Sun View Show Sun Angle Elevation View Choose View - Save this view

Wow vieving! LightSolve_Exampla

o Annual Image View: This view shows you an array of the 56 images that are tied
to the temporal maps. To change the view, use the dropdown menu at the top
left of the screen. To save a picture, click on it (screenshot below)
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File  Model: LightSolve_Example View: Annual Image View Wesather: Weather by climate (auto)

S
e S e I I e e B
. ——
i..im-'in__n
i e e e
ﬁiii‘i‘-

ary  February  Ma August  September  Octs

& | 2:Level outside corner
@ | 3:lnside view of window
——

afternoon

ng

now vieving: May 29, 2:06 pm Turbid Sky (by local :Iima!J

Weather:
o Choose to display the time-series of renderings by climate (i.e. always showing
the most likely sky condition for each point in time) or by one of four different

sky types: clear, clear-turbid, intermediate, and cloudy.

o This changes the renderings shown in both the ‘Temporal Maps / Renderings’

mode and in the ‘Annual Image View’ mode.

Saving a Lightsolve project

oMIT

All the renderings and temporal maps are automatically saved under the model
name in a folder called “My_LightSolve_Renderings”. This folder is automatically

created in the home directory of your computer.

You can access any of this past information through the LightSolve interface.
However, if you re-render a model with the same name, it will write over the

previous information. If you wish to keep both sets of data, you should change the

name of the model before you re-render, or change the folder name in
“My_LightSolve_Renderings”.

NOTE: If you had an earlier version of Lightsolve on your computer, you will have to

delete or rename any folder that has a model name you may want to re-use.

You can save any individual pictures to another spot in your windows file system by
clicking on any of the pictures in the “Annual Image View” tab or by right-clicking on

the images in the Temporal Maps/Renderings tab.
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8. Troubleshooting and Tips

TIPS:

* Toincrease your chances of having a model that will work in Lightsolve, build it step by step
and verify it every so often by running the Interactive Render. In particular, it is highly
recommended to start with a simple volume, then very soon invert all the normals (see
Chapter 1, Exercise 5, section b) and start pull/pushing volumes, windows, partitions etc
from it. This way, your normals are likely to be valid. You will spend MUCH more time trying
to fix a model that does not work than building it more slowly but carefully.

* Importing models from other programs (such as Rhino) is not impossible but is very unlikely
to result in a model that will immediately be valid because of the normals, multiple-layers,
partition joints etc. Building a simplified model from scratch will probably be more time-
efficient. The more complex the model’s geometry, the more time the simulation will take
(possibly resulting in memory overload depending on your computer) and the more
chances there will be of having problems. But if built properly and carefully, complex models
can be handled.

* Lightsolve will not work if a material name is a subset of another material name. For
example, “INVISIBLE_SENSOR” is a subset of the name “INVISIBLE_SENSOR_GLARE_01", but
“INVISIBLE_SENSOR_01" is not. To make sure that all your material names will work, we
recommend always adding a number or word after the terms “SENSOR”,
“INVISIBLE_SENSOR”, or “INVISIBLE_SENSOR_GLARE".

* Your results may be incorrect if you label an opaque material as “INVISIBLE_SENSOR.”
Please remember to set the opacity of any invisible materials to 0 in SketchUp before
running the renderer.

* If you start seeing the word “false” in the text boxes in the pop-ups, or if the program is
acting strangely in general, try the following options:
o Go to Plugins = Reload All, and try again.
o Close SketchUp, re-open your model, and try again.
o Find the model folder in My_Lightsolve_Renderings, erase the folder, and try again.

* Your Lightsolve views will not be saved in your SketchUp model. They will be saved in the
Lightsolve interface, but at present, you will need to re-make all views in SketchUp if you
change something in your model and need to re-run it.

* |f the Interactive Renderer does not work, the Full Renderer will not work either. The
Interactive Renderer is much faster to run, so it is recommended to always try an interactive
render before attempting a full render.

TROUBLESHOOTING:

If you do not see a “Plugins” menu when you open SketchUp:
- Your installation has not occurred correctly. Check to see if you have the following folder:
C:/Program Files/Google/Google SketchUp 7/Plugins/Lightsolve. If not, uninstall Lightsolve
(using Control Panel) and re-install, making sure you specify the correct path.
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If you try to run Lightsolve and do not see the remesher or if the remesher doesn’t seem to work:
- Ifyou are using Vista, make sure you have User Account Control (UAC) turned off. To find it, you
can go into Control Panel and just search for “UAC” or “User Account Control”, then just
uncheck the box.

- Make sure you have your preferences set correctly (you only need to do this once):

O
O

O
O
O

Open SketchUp and go to File = Export = 3D Model...

In the window that pops up, change the “Export type” to “OBJ”, and click the button in
the lower right marked “Options...”

Make sure “Triangulate all faces” is CHECKED

Make sure “Swap YZ coordinates (Y is up)” is CHECKED

Click “OK” and cancel out of the export

If the remesher finishes but the renderer does not start:

- Your model has been built incorrectly. Run Interactive Render and type “control” into the box
that asks if you want to see the remesher. Press the “Remesh” button on the GUI and wait until
the remesher stops. Locate any areas of your model where colors appear (other than red on
outside objects’ edges). These indicate areas where the remesher is struggling.

- Check the following:

O

O O O O O

Model is watertight (no open windows or walls)

No planes cross each other or form a “T” junction
Imported geometries have been exploded

All normals are facing the correct direction

No stray lines

For more possibilities (and for images), see section 6.

If your renderings appear completely black:
- Check to make sure all your windows are labeled with a material called “GLASS_<something>"
- Your exposure may be too low. Try increasing it.

If the interiors of your renderings appear black and the outside appears white:
- Your normals may be facing the wrong direction. Right-click all the faces that need to be
changed and select “Reverse Faces”.

If your renderings seem to finish but the interface does not appear:
- If you have successfully run a model before with the same name as your current model, try
either renaming your new model to a new name or deleting the old data files from the model
with the same name in the My_Lightsolve_Renderings folder.

- Check to make sure you have at least one illuminance or glare sensor in your model. The
interface will not appear if there is no sensor data to display.

- Check to make sure you don’t have a sensor name that is a subset of another sensor name. For
example, “INVISIBLE_SENSOR_office” is a subset of “INVISIBLE_SENSOR_officel”. Rename any
sensors that have this problem.

- Check to see if the jpgs are being created:

O
O

oMIT

Find the My _Lightsolve_Renderings folder and locate your model’s folder
Check to see if there are .jpgs called “1m1”, “1m2”, etc. in the main folder
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Check to see if there are .jpgs in the “p1c”, “plct”, “pli”, and “plo” folders
If the .jpgs are all there, try running the interface directly by double-clicking the
Runinterface.bat file in the My_Lightsolve_Renderings folder.

If the jpgs have not been created, check to see if the ppms are being created:

O
O
O

Look for files called “Im1.ppm”, “1Im2.ppm”, etc. in the main folder
Look for ppm files in the “clear”, “intermediate”, “overcast”, and “turbid” folders
If the ppms are all there, then your images have been created successfully, but your
computer has not run the commands needed to change them to jpgs. You can try to do
this manually:
= QOpen the file called create_map.bat in notepad. Look to make sure there is one
command line for each map ppm you have in your folder (i.e. for each sensor
you have in your model). If there are any lines missing, simply cut and paste the
existing command as many times as needed (change the file names in each
pasted command so that you have all the maps represented, i.e. Im1, 1m2,
1m3, 1m4, etc.).
= Double-click the create_map.bat file. You should see jpgs appear.
= [Warning: Before you do the next step, make sure your map jpgs have been
created!!!] Double-click the image_rename.bat file. This will change all your
renderings into jpgs and then delete all ppms in your folder.
= |f you have succeeded in making the jpgs, try opening the interface again.
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9. Lightsolve Metrics Appendix

The metrics used in Lightsolve differ from most existing daylighting simulation programs in two ways:
they are goal-based and they place emphasis on the temporal variation of performance.

A set of three metrics have been developed to display goal-based performance information for a user-
defined area of interest on a single temporal map and to offer a comprehensive and intuitive way to

represent annual daylight performance of a design proposal’. Zcredit per sensor
The ILLUMINATION metric condenses the portion of a AIE = total # sensors
user-defined area of interest in which the illuminance stays Erodite i .
within a chosen range to a single percent, and displays the " Partial T DesiredRange
variation of that percent over time. 160% ;[.ef?el:
It assigns full credit to sensor portions within range, and
partial credit to sensor portions out of range but within a
user-defined ‘buffer’ interval. It is referred to as o

(]

Acceptable llluminance Extent (AIE). Shetric altie:(ex: M ,
etric value (ex. llluminance

Similarly, a single number representative of overall GLARE PERCEPTION within an area of interest is
introduced as Glare Avoidance Extent (GAE) and based on the Daylight Glare Probability (DGP) metric?,
and on threshold values suggested by the author for glare tolerance®.

The derived GAE metric used in Lightsolve indicates the proportion of the glare zone or glare sensor area
(see Chapter 3) that falls above the glare threshold considered non-acceptable by the user (see
paragraph on glare sensors in Chapter 6). It can therefore represent the glare risk for a particular
location and a particular viewpoint over the year (small unique glare sensor with its normal facing that
direction) but can just as well indicate the overall glare risks for a space or a range of viewing locations
(e.g. for all the students in a classroom in the Testmodel of Chapter 1) by using a set of glare sensors all
named identically. Because this glare analysis is run annually and often for multiple viewpoints, it
required more efficient methods for computing glare’.

Finally, a new SOLAR GAINS metric called Solar Heat Scarcity/Surplus (SHS) is used to convey the
urgency of either allowing more direct solar gain or avoiding it, based on revisited balance point
calculations®. It of course requires additional input about the thermal properties of the envelope and
building type and occupancy (see Appendix 10) but is able to provide a good approximation of how
much of a liability or benefit the daylight-associated solar gains are for the proposed designs.

To allow for climate-specific calculations, the illuminance or glare for each sensor plane patch is
calculated for each of four sky types, ranging from overcast to clear. A climate-based representative
value is calculated as a weighted average from each sky type based on their occurrence during that time
period. To make whole-year calculations more efficient, the year is split into 56 periods and climate-
based data are calculated for each of them as far as the diffuse component of daylight is concerned’. A
separate calculation for zero-bounce direct sunlight is performed for 1200 sun positions (80 times of
year and 15 times of day) and results are combined to the first (diffuse) set.

’ Andersen M., Kleindienst S., Yi L., Lee J., Bodart M., Cutler, B. (2008). An Intuitive Daylighting Performance Analysis and Optimization
Approach, Building Research and Information, 36 (6), 593-607.

* Wienold, J., Christoffersen, J. (2006). Evaluation methods and development of a new glare prediction model for daylight environments with
the use of CCD cameras. Energy and Buildings 38(7), 734-757.

* Wienold, J. (2009). Dynamic daylight glare evaluation, Proc. of IBPSA 2009.

® Kleindienst S., Andersen M. (2009). The Adaptation of Daylight Glare Probability to Dynamic Metrics in a Computational Setting, In Proc. of Lux
Europa 20009.

® Kleindienst S., Andersen M. (2010). Solar Heat Surplus and Solar Heat Scarcity: The inclusion of solar heat gain in a dynamic and holistic
daylight analysis. Proc. of SimBuild 2010.

7 Kleindeinst S., Bodart M., Andersen, M. (2008). Graphical Representation of Climate-Based Daylight Performance to Support Architectural
Design, Leukos, 5 (1), 39-61.
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READING A TEMPORAL MAP

The days/months of the year are plotted along the horizontal axis, and
the times of day are plotted along the vertical axis.

Noon will thus be a horizontal line at mid-height of the graph, and end
of June a vertical line at mid-width. Black is for night (sun below
horizon). Days are longer in the summer in Boston, hence the vertical
increase in daylit hours towards the middle of the graph.

INTERPRETING GOAL-BASED PERFORMANCE 100% Too 100% Too
An intuitive color scale indicate how closely the goals were met over the year: Lo High
- yellow indicates that the goals were met for this sensor (or that
solar gains are neither excessive nor insufficient)
- red indicates that calculated values were too high (too much light)
- blue indicates that they were too low. /
NB: purple indicates that part of the sensor area was too bright and the 100%
rest too dim, green that part of it was fine and the rest too dim, etc. MEstsGoals

FUTURE OF LIGHTSOLVE: These metrics will ultimately be used in a version of Lightsolve that also
incorporates a feedback loop i.e. can act as a Virtual Consultant (see preliminary interface below). As
with the current process, an original design will be iteratively modified and improved until performance
goals are reached. The user will remain involved at each stage of the process, inputting a set of
performance goals and a 3D model of an initial design, and then considering each potential modification
as one would consider suggestions from a daylighting consultant®. By involving the designer and utilizing
his knowledge, the process is made more efficient while the exploration space is expanded.

The goal-based method will take advantage of a knowledge base populated using a set of previously
completed simulations that quantify the effects of different design modifications’. The knowledge base
will guide a simple optimization algorithm and improve its computational efficiency. It will also provide
feedback to the user indicating why certain design strategies would be selected to improve performance
over others, thus adding an educational potential to the method.

T o

File A el View: Virtual Consultant

=

South-East view INVISIBLE_SENSOR_SE

E Windows Up

thischasge  overal n
[ +4.4% \/\ +39% |
[

| Make this change

Percent in range

Tow vieving: Example_Mode|

® Lee J., Andersen M., Sheng Y., Cutler B. (2009). Goal-based Daylighting Design Using an Interactive Simulation Method. Proc. of IBPSA 2009.
° Lee J., Andersen M. (2009). A Simulation-Based Expert System for Interactive Daylighting Design. Proc. of Lux Europa 2009.
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10. Solar Gains Appendix

The tables here can help in providing some numbers for the information required to perform solar gain calculations (see section6), but their origins
should be understood. Table 1 values are taken from the 16 DOE Benchmark Commercial Building models (New Construction), and they represent

average numbers for the whole building, rather than a single space. For instance, the ventilation, occupancy, and heat gain values for a whole
school building may not be relevant for a single classroom model, whereas the U-values and SHGC would be relevant still.

Table 1: Default options for balance point calculations from the 16 DOE Commercial Building Benchmark Models [Torcellini et al., 2008; DOE, 2008]
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= 2|2 |=|=|¢ |E|E | |E|E|E|E|E|E|5 |8 |5 |S:=
g S S s S 3 =3 =3 = =3 =3 = =3 = = = = = =
& T 5 = £ =z @ @ @ @ @ @ @ @ @ = = = =
s = = = = ) = = = = E E E ] E %) %) %) %)
- g 5 5 | £ = | 3| 2 5 5 5 5 5 5 5 122 | 2 |2
Building Type:] o© > > = w 4 =) > =) =) > =) =) =) =) wn wn wn wn
Fastfood| 0.386 | 9.000 | 0.000 | 0.640 |215.20| 17.75 | 0.505 | 0.505 | 0.505 0.29 | 0.194 | 0.154 6.88 3.24 2.62 0.25 0.25 0.39 0.49
Hospital| 0.070 | 5.853 | 0.044 | 0.088 | 42.17 | 11.31 2.61 0.856 | 0.698 | 0.454 | 0.357 | 0.273 | 6.88 3.24 2.62 0.25 0.25 0.39 0.49
Large Hotel| 0.123 | 0.707 | 0.248 | 0.115 | 3258 | 10.76 | 1.285 | 1.285 | 1.285 | 1.285 | 0.564 | 0.564 6.88 3.24 2.62 0.25 0.25 0.39 0.49
Large Office] 0.517 | 10.000| 0.000 | 0.074 | 7.82 | 10.76 | 0.704 | 0.704 | 0.477 | 0.364 | 0.357 | 0.273 | 6.88 3.24 2.62 0.25 0.25 0.39 0.49
Medium Office| 0.054 | 2.500 | 0.300 | 0.167 8.07 10.76 | 0.704 | 0.704 | 0.477 | 0.364 | 0.357 | 0.273 6.88 3.24 2.62 0.25 0.25 0.39 0.49
Midrise Apartment| 0.025 | 6.180 | 0.300 | 0.251 4.22 506 | 0.704 | 0.477 | 0.364 | 0.313 | 0.357 | 0.273 6.88 3.24 2.62 0.25 0.39 0.39 0.49
Outpatient| 0.054 | 2.500 | 0.300 | 0.300 8.07 10.76 | 0.704 | 0.477 | 0.364 | 0.313 | 0.357 | 0.273 6.88 3.24 2.62 0.25 0.39 0.39 0.49
Primary School| 0.205 | 3.401 | 0.454 | 0.372 | 51.21 | 13.71 | 0.704 | 0.704 | 0.477 | 0.364 | 0.357 | 0.273 6.88 3.24 2.62 0.25 0.25 0.39 0.49
Retail| 0.078 | 3.800 | 0.600 | 0.270 | 522 | 16.65 | 2.61 0.856 | 0.698 | 0.454 | 0.357 | 0.273 | 6.88 3.24 2.62 0.25 0.25 0.39 0.49
Secondary School| 0.301 | 2.706 | 0.628 | 0.205 | 30.68 | 12.37 | 0.704 | 0.704 | 0.477 | 0.364 | 0.357 | 0.273 6.88 3.24 2.62 0.25 0.25 0.39 0.49
Sit Down Restarant] 0.537 | 2.764 | 0.655 | 0.550 | 636.61| 19.95 | 0.704 | 0.704 | 0.477 | 0.364 | 0.194 | 0.154 | 6.88 3.24 2.62 0.25 0.25 0.39 0.49
Small Hotel a a 3 a 2229 |1 19.96 | 0.704 | 0.704 | 0.477 | 0.364 | 0.357 | 0.273 6.88 3.24 2.62 0.25 0.25 0.39 0.49
Small Office| 0.054 | 10.000 | 0.000 | 0.449 8.07 10.76 2.61 0.856 | 0.698 | 0.454 | 0.194 | 0.154 6.88 3.24 2.62 0.25 0.25 0.39 0.49
Strip Mall| 0.086 | 0.000 | 15.169]11.611| 4.30 | 17.46 | 0.704 | 0.704 | 0.477 | 0.364 | 0.357 | 0.273 | 6.88 3.24 2.62 0.25 0.25 0.39 0.49
Supermarket| 0.078 | 0.215 | 0.137 | 0.247 | 13.65 | 16.71 2.61 0.856 | 0.698 | 0.454 | 0.357 | 0.273 6.88 3.24 2.62 0.25 0.25 0.39 0.49
Warehouse| 0.001 | 0.122 | 0.300 | 0.196 | 2.09 | 11.34 | 0.641 | 0.641 | 0.641 | 0.324 | 1.627 | 1.627 | 6.88 3.24 2.62 0.25 0.39 0.39 0.49

NOTES: a) This Data was not available in the files provided by the DOE [DOE, 2008].
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Table 2: The default balance point calculation values options from the Table 3: The default balance point calculation values options from “Building

ASHRAE Handbook [ASHRAE, 2000] Balance Point” [Utzinger & Wasley, 1997]
& = g
sl g | = <
) @ Y =
e | 5| 3 2
e | 2| 2 B
g | S =
s | E S =
g E E Residential Loose 2
Building Type : Sub-Type =) > > Residential Medium 0.5
Eoo: gerv!ce : Eas:food/Ctal;_et?naéBar g)g gg 83 Residential Tight 02
00 ervice : Restauran ining koom . . . " " "
Office 01 5E 03 ReS|dent|§I Too Tight <0.2
Hotel : Room 01 | 25 | 03 Commercial Loose 3.5
Hotel : Lobby 0.3 3.8 0.3 Commercial Medium 2
Hotel : Multipurpose 1.2 2.5 0.3 Commercial Tight 0.5
School : Classroom 0.3 5.0 0.6 Economizer Cycle 5
School : Lecture Hall 1.5 3.8 0.3
School : Science Lab 03 5.0 0.3 Table 2 includes values for occupancy and ventilation which are relevant for
Retail : Mall Common Area 1.0 38 0.9 single use spaces, but not whole buildings. Total ventilation for a space should
School : Gymnasium - - 15 be found using the following equation:
Auditorium 15 | 25 | 03 & g€d '
Residential : House/Appartment 0.1 2.5 0.3 o
Health Care : Patient Room 0.1 13.0 b Ventilation =
Health Care : Medical Procedure 0.2 8.0 b (Occupants/floor [m?])*(Ventilation/occupant) + (Ventilation/ floor [m?])
Health Care : Operating Room 0.2 15.0 P
. b
Health Care| : Recovery/ICU 0.2 8.0 Table 3 includes “Air changes per hour” for infiltration values for buildings of
Retail : Sales Area 0.2 3.8 0.6 diff t “ticht »  An ACH val b ted t 3/ fl b
Supermarket 06 38 K |.eren ig n'ess . n. value may be converted to m’/s per floor area by
Religious ) 55 03 using the following equation:
Library 0.1 25 0.3
Warehouse 2 i 0.3 Infiltration [m>/s/(floor [m?])] =

Infiltration [ACH]*(Volume of space [m?®])/(3600 seconds)/(floor [m*])
In all cases, floor area is in m%. A total ventilation/Infiltration per floor area would be the sum of the results of the two equations above.

NOTES: a) No recommendations were made by ASHRAE 62.1-2007 [ASHRAE, 2007].
b) Specific codes for the locality and the medical procedure should be used [ASHRAE, 2007].
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